New Features Summary

PDF download from SAP Help Portal:

Created on March 24, 2016

The documentation may have changed since you downloaded the PDF. You can always find the latest information on SAP Help Portal.

Note
This PDF document contains the selected topic and its subtopics (max. 150) in the selected structure. Subtopics from other structures are not included.
Table of content

1 New Features Summary
2 New Features v16.6
  2.1 PowerAMC Becomes PowerDesigner
  2.2 New PowerDesigner Web Features v16.6
  2.3 New Core Features v16.6
  2.4 New Data Model Features v16.6
  2.5 New Business Process Model Features v16.6
3 New Features v16.5 SP05
  3.1 New PowerDesigner Web Features v16.5 SP05
  3.2 New Core Features v16.5 SP05
  3.3 New Enterprise Architecture Model Features v16.5 SP05
  3.4 New Data Model Features v16.5 SP05
  3.5 New Data Movement Model Features v16.5 SP05
4 New Features v16.5 SP04
  4.1 New Web Client: PowerDesigner Web
  4.2 New Enterprise Architecture Model Features v16.5 SP04
  4.3 New Business Process Model Features v16.5 SP04
  4.4 New Data Model Features v16.5 SP04
  5 New Features v16.5 SP03
  5.1 New Core Features v16.5 SP03
  5.2 New SAP Platform Features v16.5 SP03
  5.3 New Business Process Model Features v16.5 SP03
  5.4 New Data Model Features v16.5 SP03
6 New Features v16.5 SP02
  6.1 New Core Features v16.5 SP02
  6.2 New SAP Platform Features v16.5 SP02
  6.3 New Business Process Model Features v16.5 SP02
  6.4 New Data Model Features v16.5 SP02
  6.5 New Object-Oriented Model Features v16.5 SP02
7 New Features v16.5
  7.1 New Core Features v16.5
  7.2 New SAP Platform Features v16.5
  7.3 New Business Process Model Features v16.5
  7.4 New Data Model Features v16.5
  7.5 New XML Model Features v16.5
8 New Features v16.1
  8.1 New Core Features v16.1
  8.2 New Data Model Features v16.1
  8.3 New Data Movement Model Features v16.1
9 New Features v16.0
  9.1 New Core Features v16.0
  9.2 New Symbol Features v16.0
  9.3 New Data Model Features v16.0
  9.4 New PowerDesigner Portal Features v16.0
10 New Features v15.3
  10.1 New Core Features v15.3
  10.2 New Business Process Model Features v15.3
  10.3 New Data Model Features v15.3
  10.4 New Repository Features v15.3
11 New Features v15.2
  11.1 New Core Features v15.2
  11.2 New Enterprise Architecture Model Features v15.2
  11.3 New Data Model Features v15.2
  11.4 New Data Movement Model Features v15.2
  11.5 New Repository Features v15.2
12 New Features v15.1
  12.1 New Core Features v15.1
  12.2 New Project and Framework Features v15.1
  12.3 New Enterprise Architecture Model Features v15.1
  12.4 New Business Process Model Features v15.1
12.5  New Data Model Features v15.1
12.6  New Data Movement Model Features v15.1
12.7  New Object-Oriented Model Features v15.1
12.8  New Repository Features v15.1
1 New Features Summary
Provides information about new features in this and recent versions.

2 New Features v16.6
The following sections describe the new features available in SAP® PowerDesigner® v16.6.

In this section:
PowerAMC Becomes PowerDesigner
Previous versions of PowerDesigner were provided as an English language installer and a separate French language installer, and the French version was called PowerAMC. From v16.6 onwards, both the English and French versions are called PowerDesigner and a single installer is delivered, which allows you to choose the installation language.

New PowerDesigner Web Features v16.6
PowerDesigner v16.6 includes new features for the PowerDesigner Web repository client.

New Core Features v16.6
PowerDesigner v16.6 includes new core features available for all models.

New Data Model Features v16.6
PowerDesigner v16.6 includes new features for the Physical Data Model (PDM).

New Business Process Model Features v16.6
PowerDesigner v16.6 includes new features for the Business Process Model (BPM).

2.1 PowerAMC Becomes PowerDesigner
Previous versions of PowerDesigner were provided as an English language installer and a separate French language installer, and the French version was called PowerAMC. From v16.6 onwards, both the English and French versions are called PowerDesigner and a single installer is delivered, which allows you to choose the installation language.

Note
When upgrading from a version of PowerAMC, the installer will uninstall PowerAMC and install PowerDesigner, while preserving all your options and preferences. If both PowerDesigner and PowerAMC are present, the installer will only update PowerDesigner.

Note
Upgrading directly from pre-v16.6 32-bit PowerAMC to v16.6 64-bit PowerDesigner is not supported. You must first upgrade to 32-bit PowerDesigner and then upgrade to 64-bit.

New PowerDesigner Web Features v16.6
PowerDesigner v16.6 includes new features for the PowerDesigner Web repository client.

Enterprise Architecture Modeling
You can now create and edit enterprise architecture diagrams in PowerDesigner Web:
Existing business communication, city planning, application architecture, service-oriented, and technology infrastructure diagrams created in the PowerDesigner desktop version are all unified as enterprise architecture diagrams on the Web and any object can be created in them. Organization charts and timeline diagrams can presently only be created and edited in the PowerDesigner desktop version, but can be displayed on the Web.

Documented in:
- PowerDesigner Web > Enterprise Architecture

Requirements Modeling

You can now create and edit requirements documents in PowerDesigner Web:

![Requirements modeling screenshot]

You can create requirements and link them to design objects in other models, external files, and other requirements. You can also create users and groups and associate them with requirements.

Documented in:
- PowerDesigner Web > Requirements

Search and Reuse

A new search dialog lets you filter by location, object type, and other criteria and can export results to Excel and PDF. A single dialog now supports searching the repository and locating objects to reuse in diagrams and to reference in other objects’ property sheets.

![Search and reuse screenshot]

Documented in:
- PowerDesigner Web > Modeling with PowerDesigner Web > Search and Reuse
Impact Analysis

A new Web analysis engine allows you to launch a graphical impact and lineage analysis on any object:

You can launch the analysis from the diagram viewer, repository, or search dialog, expand and follow connections through multiple levels, and control the display of collections and individual objects.

Documented in:
- PowerDesigner Web > Modeling with PowerDesigner Web > Impact and Lineage Analysis

Customizable Diagram Reports

You can now generate a report on objects present in any diagram (whether or not it is editable in PowerDesigner Web), and control which kinds of objects are included.

Documented in:
- PowerDesigner Web > Modeling with PowerDesigner Web > The Diagram Viewer > Generating a Report on a Diagram

Translatable Diagrams

PowerDesigner Web supports translating your diagram content for viewing in over 30 languages. Each repository has a default language for creating diagrams and objects, and users can choose the language in which they want to view model data.

Documented in:
- PowerDesigner Web > Modeling with PowerDesigner Web > Translating Diagrams

Simplified Diagram Creation

You can now create a diagram right from your workspace screen by clicking the + tile in the My Draft Diagrams section. You can also create a new process diagram by importing a BPMN 2 file exported from SAP BPM directly in the repository explorer.

Documented in:
- PowerDesigner Web > Modeling with PowerDesigner Web > The Workspace
- PowerDesigner Web > BPMN 2.0 Executable > Importing and Exporting BPMN 2.0 Files > Importing from SAP BPM

Repository Explorer Enhancements

You can now upload external files to the repository for sharing. You can also move, rename, and delete documents and folders in the repository explorer.

Documented in:
- PowerDesigner Web > Modeling with PowerDesigner Web > The Repository

Administration Enhancements

New lists of locks, activities, and change lists are now available for administrators. You can also test connections to the database, license, and LDAP servers.
2.3 New Core Features v16.6

PowerDesigner v16.6 includes new core features available for all models.

Object Name/Code Enhancements

The options surrounding the synchronization and display of object names and codes have been reorganized to simplify standard workflows:

- A new `Synchronize code` option in the `Naming Conventions` dialog allows you to control name-to-code synchronization on a model-by-model basis. This option replaces the old `Name to Code Mirroring` general option.
- `Synchronize code` is enabled by default until you reverse-engineer or import a database, business process, XML or OO code, when it will be automatically disabled to allow the free editing of object names without affecting the underlying code. You can re-enable the option at any time.
- The `Display` option, which allows you to choose between the display of object names or codes in the Browser and diagram symbols is moved from `Naming Conventions` to the `Display Preferences General Settings` tab. You can toggle between the values of this setting with the `Display Name/Code` tool in the `Standard` toolbar.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Comparing and Merging Models

Property Sheet Notes Tab becomes Definition

The `Notes` tab is renamed to `Definition` to give it more visibility, and gains a `Timestamp` tool for its `Description` and `Annotation` sub-tabs.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Objects > Object Properties > Definition Tab

Manage Users becomes Manage Users & Permissions

The `Manage Users` repository right is renamed to `Manage Users & Permissions` and now allows users to whom it is granted to list and set permissions on all repository documents without needing explicit `Full` permission.

Documented in:
- Core Features Guide > Administering PowerDesigner > Controlling Repository Access

Improved Object Sorting

A new general option, `Sort object categories alphabetically`, allows you to list object categories in the browser and `Model` menu in alphabetical order. By default, object categories are ordered by importance with core objects (such as PDM tables, CDM entities, and OOM classes) listed first. Extended collections and compositions now allow you to specify whether users can manually order them or not.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Customizing Your Modeling Environment > General Options
- Customizing and Extending PowerDesigner > Extension Files > Extended Collections and Compositions (Profile)

2.4 New Data Model Features v16.6

PowerDesigner v16.6 includes new features for the Physical Data Model (PDM).

SAP HANA Calculation Views

PowerDesigner now supports modeling SAP HANA calculation views, including import from and export to the HANA repository. Full round-trip support is provided for simple calculation views (referencing one or two tables or views), while more complex views are imported with mappings to their sources to allow their inclusion in impact analyses.

Documented in:
- Data Modeling > DBMS Definition Reference > SAP HANA

SAP HANA Core Data Services (CDS)

PowerDesigner now supports modeling and exporting CDS artifacts to:

- SAP HANA CDS Repository (up to HANA v1 SP11)
- SAP HANA CDS HDI (HANA v1 SP11 and higher)

Documented in:
- Data Modeling > DBMS Definition Reference > SAP Core Data Services (CDS)

Other Features

- The procedure signature is now taken into account when assessing name uniqueness to allow the definition of procedures with the same name and different parameters.
- New model-to-model generation options give you full control over PDM object codes to be created when generating from a CDM, LDM, PDM, or OOM.
- New tools in the CDM and LDM toolboxes allow you to create one-many dependent relationships and many-many relationships in one step.

Documented in:
New or Enhanced DBMS Support

The following DBMS versions are added or updated:

- SAP HANA® v1.0 - now includes support for SP10 and SP11, with limited support for import/export of calculation views.
- SAP HANA CDS Repository (up to HANA v1 SP11)
- SAP HANA CDS HDI (HANA v1 SP11 and higher)

Documented in:
- Data Modeling > DBMS Definition Reference

2.5 New Business Process Model Features v16.6

PowerDesigner v16.6 includes new features for the Business Process Model (BPM).

BPMN 2.0 Descriptive to Solution Manager Generation

PowerDesigner now supports generating BPMN 2.0 Descriptive process models to Solution Manager models to help you align the business and technical views of your processes and allow for the cascading of changes in the business-oriented processes to your Solution Manager server.

3 New Features v16.5 SP05

The following sections describe the new features available in SAP® PowerDesigner® v16.5 SP05.

Note

If your license entitles you to SAP platform integration features and you are upgrading from v16.5 SP02 or earlier, you should regenerate your PowerDesigner license keys at SAP Service Marketplace (SMP) at https://support.sap.com/licensekey to ensure that you have access to new features in this version.

In this section:

- New PowerDesigner Web Features v16.5 SP05
- New Core Features v16.5 SP05
- New Enterprise Architecture Model Features v16.5 SP05
- New Data Model Features v16.5 SP05
- New Data Movement Model Features v16.5 SP05
- New PowerDesigner Web Features v16.5 SP05

New PowerDesigner Web Features v16.5 SP05

PowerDesigner v16.5 SP05 includes new features for the PowerDesigner Web repository client. All these features are documented in a new manual entitled PowerDesigner Web.

Process Maps

You can now create and edit multi-level process maps in PowerDesigner Web. A top-level process map can contain architecture areas, business functions, and processes. You can create sub-maps to decompose processes into sub-processes and associate sub-processes with BPMN 2.0 process diagrams to define their steps in detail.
Verifying Diagrams
When editing a process map or BPMN 2 diagram, you can verify it against the built-in rules. Errors and warnings associated with an object are shown in bubbles above its symbol in the diagram, and the relevant facet and property in its property sheet are highlighted where possible. Once activated, verification continues dynamically, decreasing bubble counts as you correct diagram issues.

Custom Properties
Administrators can define custom properties for objects in process maps and BPMN 2.0 process diagrams, and these will be instantly available for all objects of the specified type.

Single Sign-On
In environments where X.509 client authentication is in place, an administrator can enable PowerDesigner Web to authenticate users by the user certificate stored on their client machine. The client browser sends a certificate issued by a trusted certificate authority to identify the user and they are logged in automatically, without the need to manually enter their credentials.

Repository Creation and Administration
The PowerDesigner Web installer will automatically create the repository in an empty database, if it is not already present. Administrators can now create users and groups, and grant rights and permissions, define a password policy, and reset passwords through the new Administration tile. This tile also allows administrators to modify the database and license server connections and connect to an LDAP server and an SMTP server.

Multi-Language Support
The PowerDesigner Web interface can now be viewed in:
- English
- French
- German
- Spanish
- Chinese
- Russian

Diagram Editor and Property Sheet Improvements
The following new features are available:
- Reports - Standard reports can now be generated for process diagrams and process maps in PDF and Word formats.
- Print diagram - You can now print any diagram available in PowerDesigner Web by clicking Menu > Print Diagram.
- Link sharing - You can now generate a simplified URL to any diagram or object property sheet by selecting Menu > Share Link.
- Continuous zoom - When an object contains a sub-diagram or related diagram, zooming into its symbol opens the contained diagram. Zooming out of a contained diagram opens the parent diagram.
- Comments improvements - The Comments pane can now be positioned anywhere in your window. In addition, comment bubbles are always visible in your diagram when there are open comments. Comments are now also visible when comparing a diagram to the latest published version before publication.
- Property sheet improvements:
  - The Children (formerly Contents) facet - Now supports the creation of child objects.
  - The Depends on (formerly Uses) facet - Now supports linking to business rules.
- The **Diagrams** facet - Now supports linking to related diagrams.
- The new **Versions** facet - Lists all the versions of the model published in the repository, with a separate list per branch where appropriate. To compare two versions of a model in a single branch, select their checkboxes and click the **Compare** tool.
- The new **Permissions** facet - Lists the users and groups with permissions to view and edit the contents of the folder or the diagrams in the model. Users with **Full** permission on the object and administrators can modify the permissions.

**SAP BPM Bridge**

PowerDesigner Web now makes your process models available for browsing and importing directly into the SAP NetWeaver Developer Studio Process Composer v7.3 EHP1 SP15 or higher.

Documented in:

### 3.2 New Core Features v16.5 SP05

PowerDesigner v16.5 SP05 includes new core features available for all models.

**Compare and Merge Enhancements**

You can now exclude changes in the order of members of an orderable collection from the differences displayed during a model compare or merge. In addition, for PDM objects with owners, the owner is now included in the object identifier so that objects that appear in both models with the same name but different owners are treated as separate objects.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Comparing and Merging Models

**Sharing Templates and Resource Files via the Library**

All PowerDesigner resource files and model, report, and project templates can now be shared via the library and pushed to all PowerDesigner users when they connect to the repository.

Documented in:
- Core Features Guide > Administering PowerDesigner > Deploying an Enterprise Glossary and Library > Deploying an Enterprise Library

**Secure Locations and Trusted Files**

To reduce the risk posed by malicious scripts, you can now instruct PowerDesigner to notify you when an untrusted script embedded in or called from a model or resource file is run, to prompt you for permission to run an untrusted script, or to block such scripts from running altogether.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Customizing Your Modeling Environment > General Options > Security Options

**Scripting Repository Users, Groups, and Configurations**

You can now create, update, and delete repository users and groups, and grant them rights and permissions through scripting. Repository configurations, which group sets of repository document versions together, can now also be scripted.

Documented in:
- Customizing and Extending PowerDesigner > Scripting PowerDesigner

**Integration via Change List**

Users with the **Submit** permission on a branch can now propose the integration of changes to that branch via a change list.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > The Repository > Change Lists

**Excel Import Performance Improvements**

A new option allows you to opt out of validating your model objects during the import, which can provide significant performance improvements. Data integrity can be confirmed after the import by selecting **Tools** > **Check Model** (or pressing **F4**).

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Objects > Importing Objects from Excel Files

**Shortcut Helper**

A shortcut cannot serve as the child object for a parent/child hierarchy link (for example, a PDM reference link between two tables or a CDM inheritance link). In the case of internal shortcuts only, if you create such a link, PowerDesigner creates a shortcut to the parent object in the child object package, then creates the link in the child object package, and creates a shortcut to the link in the parent object package.

Documented in:
- Core Features Guide > Linking and Synchronizing Models > Shortcuts and Replicas
3.3 New Enterprise Architecture Model Features v16.5 SP05

PowerDesigner v16.5 SP05 includes new features for the Enterprise Architecture Model (EAM).

New Role Association, Impact, and Fulfillment Tools

You can now draw these links directly in your diagrams using the new Toolbox tools.

Documented in:
- Enterprise Architecture Modeling > Organization Architecture Modeling > People (EAM) > Associating a Person, Organization Unit, or Role with an Object
- Enterprise Architecture Modeling > Goal and EA Initiative Modeling

3.4 New Data Model Features v16.5 SP05

PowerDesigner v16.5 SP05 includes new features for the Physical Data Model (PDM).

Enhanced ERwin Import

PowerDesigner can now import ERwin v8.x and v9.x files.

Documented in:
- Data Modeling > Building Data Models > Migrating from ERwin to PowerDesigner

New or Enhanced DBMS Support

The following DBMS versions are added or updated:
- SAP HANA® v1.0 - now includes support for Fast Data Access and extended tables.
- Netezza v7.0
- DB2 os/390 v11
- DB2 LUW v10.5

Documented in:
- Data Modeling > DBMS Definition Reference

3.5 New Data Movement Model Features v16.5 SP05

PowerDesigner v16.5 SP05 includes new features for the Data Movement Model (DMM).

SAP Data Services

You can now import and export SAP Data Services project files to analyze and modify your Data Services ETL jobs in PowerDesigner.

Documented in:
- Data Movement Modeling > ETL Modeling > SAP Data Services

4 New Features v16.5 SP04

The following sections describe the new features available in SAP® PowerDesigner® v16.5 SP04.

Note

If your license entitles you to SAP platform integration features and you are upgrading from v16.5 SP02 or earlier, you should regenerate your PowerDesigner license keys at SAP Service Marketplace (SMP) at https://support.sap.com/licensekey to ensure that you have access to new features in this version.

In this section:

New Web Client: PowerDesigner Web
- PowerDesigner v16.5 SP04 includes a new Web client for accessing your PowerDesigner repository: PowerDesigner Web.

New Enterprise Architecture Model Features v16.5 SP04
- PowerDesigner v16.5 SP04 includes new features for the Enterprise Architecture Model (EAM).

New Business Process Model Features v16.5 SP04
- PowerDesigner v16.5 SP04 includes new features for the Business Process Model (BPM).

New Data Model Features v16.5 SP04
- PowerDesigner v16.5 SP04 includes new features for the Physical Data Model (PDM).

New Web Client: PowerDesigner Web

PowerDesigner v16.5 SP04 includes a new Web client for accessing your PowerDesigner repository: PowerDesigner Web.

No Deployment Repository Access

Users can easily connect to the repository from their PC or mobile device using a modern Web browser. Standard PowerDesigner repository accounts and folder and model-level permissions are supported transparently and (if LDAP support is enabled and suitable default permissions are set) anyone with a
corporate login can connect and browse your models and objects.

Rich Diagram and Object Browsing Experience

PowerDesigner Web gives you access to the whole repository, with diagram previews in large thumbnail tiles. The new Diagram Viewer displays your model diagrams as rich SVG images zoomable up to 10x actual size, with support for full-screen diagram viewing, image export, and stable URLs for easy sharing.

Your personal Workspace contains a list of recently viewed diagrams in which you can pin favorites to keep.

Creating and Editing BPMN 2.0 Business Process Diagrams

Business users can now document their own processes directly in PowerDesigner Web using the standard BPMN 2.0 Descriptive and Executable languages. The simplified bottom toolbar provides everything you need to get started and the in-context toolbar lets you build sequences of activities, gateways, and events quickly and intuitively:

A new auto-complete feature makes reusing library objects faster and easier.

Your diagrams in progress are private, and are accessible only from your Workspace, but you can invite other users to review and comment on them before submitting them for publication.

Comments

Any user with permission to view a diagram can comment on any of its objects. Objects that have been commented on display a comments flag and you can filter comments by selecting objects. You can reply to comments and receive notifications when new comments are created. Comments are supported on both published and draft models and comments made on published models are retained across versions.
Visual Compare

You can review the differences between a diagram in progress and the published version using the new visual compare:

In-Web Review and Publication

In most cases, senior modelers can review and publish diagrams directly in PowerDesigner Web. The comment mechanism supports the discussion of changes between modeler and reviewer, and the visual compare makes tracking changes easier than ever.

Charts

Dynamically-generated charts allow real-time monitoring and analysis of models. Charts are available only in PowerDesigner Web and are accessible from the Charts facet of model property sheets and from the Dashboard tile on your homepage, which collates all the charts for which you have permission in the repository:
The datasets that drive charts are defined in extension files in the PowerDesigner desktop client and uploaded to the repository, where they can be associated with models using PowerDesigner Web.

An EAM extension file containing example datasets is loaded by default in your repository Library folder and an example enterprise architecture model and charts are provided in a sample repository.

Documented in:
- PowerDesigner Web

## 4.2 New Enterprise Architecture Model Features v16.5 SP04

PowerDesigner v16.5 SP04 includes new features for the Enterprise Architecture Model (EAM).

### Programs, Projects, Goals, and Timelines

PowerDesigner now supports the modeling of EA initiatives in the form of programs and projects. These objects can be linked to corporate goals to show how they contribute to their fulfillment and to any other EAM object to show how they may impact them:

![Programs and Projects Diagram](image)

Your initiatives and goals can be displayed in any of the standard EAM diagrams and also in the new, calculated timeline diagrams, which show your initiatives on a timeline in the context of the objects with which they are connected:

![Timeline Diagram](image)

Documented in:
- Enterprise Architecture Modeling > Goal and EA Initiative Modeling
Composite Processes
EAM processes can now contain sub-processes and sub-process maps to support the construction of multi-level EAM process maps:

![Composite Processes Diagram]

Documented in:
- Enterprise Architecture Modeling > Process and Function Modeling > Processes (EAM)

Visualizing Role Associations
EAM role associations (which model connections between people, organization units, and roles, and various EA objects) can now be displayed in diagrams:

![Visualizing Role Associations Diagram]

Documented in:
- Enterprise Architecture Modeling > Organization Architecture Modeling > People (EAM) > Associating a Person, Organization Unit, or Role with an Object

New Example EA Model, Excel Imports, and Charts
To demonstrate these new features and the dynamic charts available in the new PowerDesigner Web repository Web client (see New Web Client: PowerDesigner Web), a rich new EAM example model is provided. The model also serves to present one possible set of choices for structuring your EA metadata in the flexible PowerDesigner EAM metamodel and can serve as a starting point for your own deliberations:
4.3 New Business Process Model Features v16.5 SP04

PowerDesigner v16.5 SP04 includes new features for the Business Process Model (BPM).

BPMN 2.0 Executable and Descriptive Languages

PowerDesigner now supports generation to and reverse-engineering from SAP BPM v7.3 and higher and Eclipse BPMN2 Modeler for both the BPMN 2.0 Executable and BPMN 2.0 Descriptive language variants. The new generation is based upon the objects present in the diagram with current focus.

The two BPMN variants have been harmonized so that both now allow reuse of lanes in different pools.

You can now create and edit BPMN 2.0 diagrams in a Web browser, using the new PowerDesigner Web (see New Web Client: PowerDesigner Web).

4.4 New Data Model Features v16.5 SP04

PowerDesigner v16.5 SP04 includes new features for the Physical Data Model (PDM).

New or Enhanced DBMS Support

The following DBMS versions are added:

- Greenplum v4.2
- Hadoop Hive v1.0
- Microsoft SQL Server 2014

5 New Features v16.5 SP03
In this section:

New Core Features v16.5 SP03
PowerDesigner v16.5 SP03 includes new core features available for all models.

New SAP Platform Features v16.5 SP03
PowerDesigner v16.5 SP03 includes new support for SAP platform solutions.

New Business Process Model Features v16.5 SP03
PowerDesigner v16.5 SP03 includes new features for the Business Process Model (BPM).

New Data Model Features v16.5 SP03
PowerDesigner v16.5 SP03 includes new features for the Physical Data Model (PDM).

5.1 New Core Features v16.5 SP03
PowerDesigner v16.5 SP03 includes new core features available for all models.

Report Charts
You can now add column, bar, and pie charts to reports to visualize information about your models and objects.

Hardware Servers

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Reports > The Report Editor

Excel Import Supports Shortcuts
The Excel Import extension (which provides a wizard for mapping lists of objects defined in Excel worksheets to PowerDesigner objects and properties and importing them) now supports searching in models open in the Workspace to resolve object references. For example, PDM table columns listed in your Excel file can reference domains that are defined in an existing model, and the wizard will create shortcuts to them doing the import.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Objects > Importing Objects from Excel Files

New Environments
The following new environments are supported:
- Windows 8.1
- Eclipse 4.3

Other Features
- Generic extension files such as Excel Import that can be attached to any type of model no longer appear on the module-specific extensions lists but have their own list available at Tools > Resources > Extensions > All Model Types. This list allows you easily to create your own generic extensions.
- The Find in Diagram command, which allows you to find symbols associated with an object selected in the Browser, an object list, or the Result List window now also finds symbols representing shortcuts to the object and protected symbols.

5.2 New SAP Platform Features v16.5 SP03
PowerDesigner v16.5 SP03 includes new support for SAP platform solutions.

**Note**
If your license entitles you to SAP platform integration features and you are upgrading from v16.5 SP02 or earlier, you should regenerate your PowerDesigner license keys at SAP Service Marketplace (SMP) at https://support.sap.com/licensekey to ensure that you have access to new features in this version.

**SAP Business Suite Import and Generation to HANA Enhancements**
The SAP® Business Suite import wizard now supports searching the application component and package hierarchy for tables and views to import. The generation of the HANA table structure now supports the suppression of empty packages to simplify the structure for export.

**SAP BusinessObjects Enhancements**
PowerDesigner now supports reverse-engineering of universes in addition to the existing generation to provide a full round-trip solution.

To generate universes, you must have SAP® BusinessObjects™ SBOP BI Platform Clients 4.0 SP04 Patch 3 (v14.0.4.819) or higher installed on your workstation. On Windows Vista or Windows 7 machines, if PowerDesigner fails to recognize a valid BusinessObjects installation, it may be necessary separately to launch the Universe Design tool one time with administrator privileges to enable the BusinessObjects SDK.

To reverse-engineer universes, you must have SAP® BusinessObjects™ Business Intelligence platform 4.1 Support Package 2 Client Tools or higher installed on your workstation, and you must have selected to install the SAP BusinessObjects Semantic Layer Java SDK.

**5.3 New Business Process Model Features v16.5 SP03**
PowerDesigner v16.5 SP03 includes new features for the Business Process Model (BPM).

**BPMN 2.0 Executable and Descriptive Languages**
PowerDesigner now supports two variants of BPMN 2.0:
- BPMN 2.0 Executable - To be used when reverse-engineering from SAP BPM or Eclipse BPMN2 Modeler. Provides strong links between participants, their lanes, and their associated events, activities, gateways, data, and flows.
- BPMN 2.0 Descriptive - A less restrictive version, which is more suited to lighter analysis modeling and allows reuse of lanes in different pools.

**Note**
When opening BPMN models created in previous versions of PowerDesigner, you will be invited to choose between converting them to BPMN Descriptive or keeping them in the BPMN Executable format that was originally supported.

**5.4 New Data Model Features v16.5 SP03**
PowerDesigner v16.5 SP03 includes new features for the Physical Data Model (PDM).

**SAP BusinessObjects Universe Reverse-Engineering**
PowerDesigner reverse-engineering SAP BusinessObjects universes to provide a full round-trip solution for modeling your universes.

**SAP Business Suite Import Enhancements**
PowerDesigner now supports searching the SAP Business Suite application component and package hierarchies to select items to import, and you can now choose to not generate empty packages when generating and exporting a HANA table structure.

**New or Enhanced DBMS Support**
The following DBMS versions are added:
- SAP HANA® v1.0 SP7
- SAP® Adaptive Server® Enterprise v16
- Oracle 11gR2 (in the Oracle 11g DBMS definition file) and Oracle 12c
- Oracle database package Specification tab and round-trip reverse-engineering and generation of the specification.
6 New Features v16.5 SP02

The following sections describe the new features available in SAP® PowerDesigner® v16.5 SP02.

In this section:
- New Core Features v16.5 SP02
- New SAP Platform Features v16.5 SP02
- New Business Process Model Features v16.5 SP02
- New Data Model Features v16.5 SP02
- New Object-Oriented Model Features v16.5 SP02

6.1 New Core Features v16.5 SP02

PowerDesigner v16.5 SP02 includes new core features available for all models.

64-Bit PowerDesigner

PowerDesigner is now available in both 32-bit and 64-bit versions to allow you to take full advantage of your 64-bit Windows machine.

Porting the Repository to a Different DBMS

PowerDesigner now provides a mechanism for porting an existing repository to a new DBMS, retaining all your repository folder and branch structure and version histories.

Other Features

- The new /Show shortcuts general option allows you to enable or disable the display of shortcuts in the Browser.
- The new /Apply profiles repository general option reapplies UI preference and general preference profiles at every repository connection to help ensure modeling consistency.
- You can now compare models that target different DBMS or language definition files, allowing you to, for example, compare a PDM targeting an Oracle DBMS with a PDM targeting an SAP® Sybase® Adaptive Server® Enterprise DBMS.
- Code uniqueness rules have been loosened for the glossary model, which now allows multiple terms to have the same code.

6.2 New SAP Platform Features v16.5 SP02

PowerDesigner v16.5 SP02 includes new support for SAP platform solutions.

SAP HANA Enhancements

PowerDesigner supports round trip reverse-engineering and generation of SAP HANA® v1.0 tables and analytic and attribute views, and limited support for reversing and generating calculation views. This version includes new support for table partitioning.

SAP Business Suite Import and Generation to HANA

An SAP® Business Suite installation is built on a complex database structure, which comprises many thousand tables with often cryptic names, and may include large numbers of extensions. In certain environments, there may be multiple servers, each with different extensions. PowerDesigner allows you to:
- Browse the application component and package hierarchy using their human-readable short descriptions as identifiers.
- Import components, packages, and their supporting logical objects for analysis, comparison, and merging of data dictionaries.
- Generate and export a HANA table structure to allow consolidated reporting on one or more SAP Business Suite installations.
PowerDesigner supports importing any recent version of SAP® Business Suite.
Documented in:
- Data Modeling > DBMS Definition Reference > SAP Business Suite

### SAP Solution Manager Enhancements

PowerDesigner now supports the importing and editing of scenario flow diagrams and importing additional logical components from the system landscape defined on your server for use in your processes. Documentation handling is improved to allow the importing of document types and statuses and the creation of new project documentation of type URL in PowerDesigner.

PowerDesigner supports round-trip importing and exporting of SAP® Solution Manager v7.1 SP07 to SP13 projects.
Documented in:
- Business Process Modeling > SAP Solution Manager

### SAP BusinessObjects Enhancements

A new option lets you exclude blob columns when generating the universe business layer.

To generate universes, you must have SAP® BusinessObjects™ SBOP BI Platform Clients 4.0 SP04 Patch 3 (v14.0.4.819) or higher installed on your workstation. On Windows Vista or Windows 7 machines, if PowerDesigner fails to recognize a valid BusinessObjects installation, it may be necessary separately to launch the Universe Design tool one time with administrator privileges to enable the BusinessObjects SDK.

Documented in:
- Data Modeling > Building Data Models > Generating and Reverse-Engineering Databases > Generating an SAP BusinessObjects Universe

### 6.3 New Business Process Model Features v16.5 SP02

PowerDesigner v16.5 SP02 includes new features for the Business Process Model (BPM).

### SAP Solution Manager Enhancements

PowerDesigner now supports importing scenario flow diagrams and additional logical components as well as document types and statuses (see New SAP Platform Features v16.5 SP02).

### 6.4 New Data Model Features v16.5 SP02

PowerDesigner v16.5 SP02 includes new features for the Physical Data Model (PDM).

### New Modify Cubes Wizard

A new wizard helps you update existing cubes to reflect changes made to your operational tables or simply to add or remove dimensions, measures, or attributes.

Documented in:
- Data Modeling > Building Data Models > Multidimensional Diagrams

### SAP Business Suite Import and Generation to HANA

PowerDesigner now supports browsing, importing, and merging SAP Business Suite application component and package hierarchies and generating and exporting a HANA table structure to allow consolidated reporting on them (see New SAP Platform Features v16.5 SP02).

### New or Enhanced DBMS Support

The following DBMS versions are added:
- SAP HANA® v1.0 SP6 (see New SAP Platform Features v16.5 SP02)
- SAP® IQ v16
- IBM DB2 UDB v10
- Teradata v14

Documented in:
- Data Modeling > DBMS Definition Reference
6.5 New Object-Oriented Model Features v16.5 SP02

PowerDesigner v16.5 SP02 includes new features for the Object-Oriented Model (OOM).

Technical Architecture Modeling (TAM)

Technical Architecture Modeling is the SAP internal standard for architecture modeling and combines elements of FMC and UML. PowerDesigner now supports TAM, including block diagrams:

Documented in:
- Object-Oriented Modeling > Object Language Definition Reference > Technical Architecture Modeling (TAM)

7 New Features v16.5

The following sections describe the new features available in PowerDesigner v16.5.

In this section:
- New Core Features v16.5
- New SAP Platform Features v16.5
- New Business Process Model Features v16.5
- New Data Model Features v16.5
- New XML Model Features v16.5

7.1 New Core Features v16.5

PowerDesigner v16.5 includes new core features available for all models.

Reports

The PowerDesigner Report Editor has been completely rearchitected to provide a more powerful graphical environment in which to design your model and multi-model reports:
- The synchronized Design and Outline views allow you to work on the detailed content and formatting of report elements in the context of the overall structure.
- Extensions are handled seamlessly in the Toolbox and other views.
- Report item, content and format editing are simplified and easily accessible through the Design view command bar, and changes are instantly visible.
- Titles and free text paragraphs are editable directly in the Design view.
- HTML generation is rebuilt to provide a modern, easily-configurable output.

To allow you time to experiment with the new format and editor, and to migrate your existing reports at your chosen pace, this version of PowerDesigner will continue to support the legacy Report Editor, which is now deprecated and will be removed in a future release. This release provides the option to create reports in the new or legacy format, and a simple one-click upgrade is provided to convert existing reports to the new format.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Reports

Change Lists

The new Submit permission provides administrators with finer control over changes to repository documents. Users with this permission, which can be set on a repository folder or model, are required to check their changes into a change list to be reviewed by one or more reviewers instead of writing directly to the location. Users with the Write permission can voluntarily check into a change list.

Users can add one or more models or other documents to a change list all at once, or over several check ins. Documents checked into a change list are stored in a special folder in the repository and their contents are not available to other users until they have been approved.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > The Repository > Change Lists

Importing XML Files

You can now import objects from an XML file by defining mappings between the elements in the XML schema and objects in the PowerDesigner metamodel.
(and extensions). The import mappings are defined in an extension file, can be shared with all users through the repository library, and are accessed by selecting File > Import <Import Name>.

Object Generation Enhancements
You can now define advanced object generations to generate one or more types of object to any other types of object, with complete control over how all the attributes, compositions (sub-objects), and aggregations (related objects) will be mapped to the generated objects’ properties. The generation mappings are defined in an extension file, can be shared with all users through the repository library, and are accessed by selecting Tools > Generate Objects <Generation Name>.

Repository Branch Enhancements
The new branching mechanism introduced in v16.1 has been enhanced to provide:
- A branch filter in the Browser Repository tab:
- Model permissions per branch.

PowerDesigner Portal Enhancements
The following enhancements have been made to the PowerDesigner Portal:
- Branch filtering in the Repository Explorer.
- Support for change lists.

Repository Local Model Cache
A new local cache on your workstation is provided to speed up checking models into and out of the repository.

Up-to-Dateness of Shortcuts Visible in Browser
The models listed in the Target Models category of the Browser now display status icons to indicate whether a newer version is available in the Repository.

Documented in:
- Core Features Guide > Linking and Synchronizing Models > Shortcuts and Replicas > Working with Target Models

7.2 New SAP Platform Features v16.5

PowerDesigner v16.5 includes new support for SAP platform solutions.

SAP HANA

PowerDesigner supports modeling and round trip reverse-engineering and generation of SAP HANA® Database v1.0 SP5 tables and analytic and attribute views.

![Repository Objects](image1)

Documented in:
- Data Modeling > Data Models > Reverse-Engineering Databases > Generating and Reverse-Engineering Databases

SAP BusinessObjects

PowerDesigner supports generation of a SAP® BusinessObjects™ universe from your PDM for editing in the BusinessObjects Universe Design or Information Design tools, or for direct consumption by the Web Intelligence rich client. Generating a universe from your PDM gives you access to table, view, and column names and comments and more reliable cardinality information than if you create a universe directly from your database.

![Solution Manager Import Wizard](image2)

Documented in:
- Data Modeling > Data Models > Generating and Reverse-Engineering Databases > Generating an SAP BusinessObjects Universe

SAP Solution Manager

PowerDesigner supports modeling and round trip reverse-engineering and generation of SAP® Solution Manager v7.1 business processes.
SAP NetWeaver

PowerDesigner supports modeling and round trip reverse-engineering and generation of BPMN2 files, with a particular emphasis on supporting SAP BPM v7.3 and higher, SAP Streamwork tools, and the Eclipse BPMN2 Modeler.

7.3 New Business Process Model Features v16.5

PowerDesigner v16.5 includes new features for the Business Process Model (BPM).

BPMN 2.0 Enhancements

PowerDesigner supports modeling and round trip reverse-engineering and generation of BPMN2 files, with a particular emphasis on supporting SAP BPM v7.3 and higher, SAP Streamwork tools, and the Eclipse BPMN2 Modeler.

SAP Solution Manager

PowerDesigner supports modeling and round trip reverse-engineering and generation of Solution Manager v7.1 business processes.

7.4 New Data Model Features v16.5

PowerDesigner v16.5 includes new features for the Physical Data Model (PDM).

Improved Cube Support

The PowerDesigner metamodel for cubes has been refined and extended to simplify modeling of multidimensional objects.

New or Enhanced DBMS Support

The following DBMS versions are added:

- SAP HANA Database v1.0 SP5 (see New SAP Platform Features v16.5)
- IBM DB2 for Common Server v8.x - Federated System support
- Sybase® SQL Anywhere® v16.0
- Microsoft SQL Server 2012
- Green Plum 4.2 (not certified, not documented)

7.5 New XML Model Features v16.5
PowerDesigner v16.5 includes new features for the XML Model (XSM).

**Reverse-Engineering Enhancements**

The reverse-engineering mechanism has been completely re-architected to support reverse engineering of both local files and URLs, including multiple schemas connected through Import and Include elements. File dependencies are displayed in a tree form, and any file can be substituted for an appropriate other file or URL or by an existing XML model:

Each schema is imported as a separate XML model with appropriate shortcuts connecting them.

Documented in:
- XML Modeling > Generating and Reverse Engineering XML Schemas and Other Models

**Complex Type Enhancements**

XSM support for complex types has been enhanced to provide the following:
- Elements typed with a complex type deploy the complex type and child elements on their symbols.
- Mappings can be created to or from individual instances of the complex type in the Mapping Editor.
- Shortcuts to complex types in other models can be displayed and mapped to in the Mapping Editor.

Documented in:
- XML Modeling > XML Diagrams > Complex Types (XSM)

**XML Model Generation Enhancements**

New global generation options support generating PDM tables and OOM classes as elements with or without complex types and PDM columns and OOM attributes as elements or attributes, while object-by-object generation settings are supported through an extension.

Documented in:
- Core Features Guide > Linking and Synchronizing Models > Generating Models and Model Objects

## 8 New Features v16.1

The following sections describe the new features available in PowerDesigner v16.1.

In this section:
- New Core Features v16.1
- PowerDesigner v16.1 includes new core features available for all models.
- New Data Model Features v16.1
- PowerDesigner v16.1 includes new features for the Physical Data Model (PDM).
- New Data Movement Model Features v16.1
- PowerDesigner v16.1 includes new features for the Data Movement Model (DMM).

### 8.1 New Core Features v16.1

PowerDesigner v16.1 includes new core features available for all models.
Repository Branch Enhancements

Branches in the repository have been completely re-architected to allow:

- The simultaneous display of all branches in the repository browser:

- Branching on a folder-by-folder basis.
- Simplified version numbering
- Greater flexibility and control over branch contents
- Simplified integration of changes from one branch to another.

Documented in:

- Core Features Guide > Modeling with PowerDesigner > The Repository > Branching Version Trees

Local Browser Filter

The Local tab of the Browser now includes a filter. To filter the Browser tree, start typing the name of an object that you want to find in the Filter box:

- Core Features Guide > Modeling with PowerDesigner > The Browser

Enterprise Glossary Enhancements

The glossary has been enhanced to provide:

- A single view with integrated filtering of all objects supported by the glossary:

- Glossary terms lists - which present terms and their definitions in a filterable list format in the canvas.
- Support for creating list reports and dependency matrices in the glossary.
- New model checks on the model and packages to summarize all the terms in object names that are not in the glossary and which allow users with the appropriate permissions to merge these missing terms into the glossary.

Documented in:

- Core Features Guide > Modeling with PowerDesigner > The Browser > The Glossary
- Core Features Guide > Administering PowerDesigner > Deploying an Enterprise Glossary and Library

Enterprise Library Enhancements

The library now supports pushing DBMS and language definition files, extensions, and other resource files to users. Resource files synchronized through the
library are automatically included in resource file lists, the New Model dialog, and anywhere where a resource file can be selected.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > The Browser > The Library
- Core Features Guide > Administering PowerDesigner > Deploying an Enterprise Glossary and Library

Security Enhancements

Repository and database security is enhanced as follows:
- A password is now required to connect to the repository, and connection passwords are not saved locally.
- Administrators have granular control over the complexity and lifetime of passwords via a password policy:

All communication between the PowerDesigner client and the repository proxy are encrypted. Communications between the proxy and the repository server or between PowerDesigner and a database via ODBC or JDBC can be encrypted if the driver supports it.

In the event that no administrator is able to log in to a running repository, it is now possible to create an emergency administrator account to regain access.

Documented in:
- Core Features Guide > Administering PowerDesigner > Controlling Repository Access

PowerDesigner Portal Enhancements

The following enhancements have been made to the PowerDesigner Portal:
- Quick search is now available on all PowerDesigner Portal tabs.
- Rich text editing is now supported directly in the PowerDesigner Portal, including support for creating and editing tables, images, and hyperlinks.
- Support for modifying the new repository password policy.

Documented in:

IPv6 Support

PowerDesigner now supports communication between client machines and the repository or proxy in IPv6 environments and in mixed IPv4/IPv6 environments.

Multiple Paths in Resource Lists

You can now specify multiple paths for each type of resource file, and PowerDesigner will search all of these paths and combine the results in order to populate resource file lists.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Customizing Your Modeling Environment > PowerDesigner Resource Files

Symbol Improvements

The following enhancements are provided for working with symbols:
- The Keep size format option can now be applied to composite symbols so that they do not expand, even when you create additional sub-objects inside them.
- The three labels that can be displayed at the source, center, and destination of link symbols can now be resized independently. To revert to the default word-wrapping, select the label and press Ctrl + J.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Diagrams, Matrices, and Symbols > Symbols > Symbol Format Properties
Reports Support SVG Generation for HTML5-Compliant and Older Browsers

PowerDesigner now supports generating SVG diagrams in reports for both HTML5-compliant and older browsers. You should specify the primary type of browser that will be used to view your HTML report in the report property sheet.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Reports > The Report Editor > Report Properties

Shortcut Improvements

The improvements made to external shortcuts from one model to another, which allow them to display all the properties of their source object even when its model is closed or unavailable, are now provided for the XML model (XSM) in addition to all the other model types.

Documented in:
- Core Features Guide > Linking and Synchronizing Models > Shortcuts and Replicas

Metaclasses Defined in Extensions in Permissions Profiles

You can now control the availability of metaclasses defined in a DBMS, language definition, or extension file with a permission profile.

Documented in:
- Core Features Guide > Administering PowerDesigner > Customizing the PowerDesigner Interface > Using Profiles to Control the PowerDesigner Interface

8.2 New Data Model Features v16.1

PowerDesigner v16.1 includes new features for the Physical Data Model (PDM).

Sybase IQ Reference Architecture Sizing

The advisor wizard now supports modeling for logical servers for Sybase® IQ v15.3 and v15.4 and also allows you to specify different hardware profiles for the reader, writer, and coordinator nodes.

Documented in:
- Enterprise Architecture Modeling > SAP IQ Reference Architecture Model

New or Enhanced DBMS Support

The following DBMS versions are added:
- Sybase IQ v15.3 and v15.4

Documented in:
- Data Modeling > DBMS Definition Reference

8.3 New Data Movement Model Features v16.1

PowerDesigner v16.1 includes new features for the Data Movement Model (DMM).

Replication Server® v15.7

Replication Server v15.7 and higher supports multi-path replication of Adaptive Server Enterprise v15.7 and higher primary databases to increase replication throughput and performance, and reduce contention. PowerDesigner provides support for multi-path replication by letting you:
- Draw multiple parallel connections between a database and replication server and specify which is the default path.
- Specify logical connections to distribute data and objects bound to a physical path to multiple Replication Servers.

Documented in:
- Data Movement Modeling > Working with Replication Server
9 New Features v16.0

The following sections describe the new features available in PowerDesigner v16.0.

Note
The documentation for the repository has been moved to the Core Features Guide in this version. In addition, a new Quick Reference guide, which provides an overview of core and module-specific features, is available as a PDF and as part of the online help collection.

In this section:
- New Core Features v16.0
- New Symbol Features v16.0
- New Data Model Features v16.0
- New PowerDesigner Portal Features v16.0

9.1 New Core Features v16.0

PowerDesigner v16.0 includes new core features available for all models.

New Interface
The code underpinning the PowerDesigner interface has been rewritten to provide a contemporary look and feel.

The new environment provides:
- A dockable toolbox with an autohide option, list and icon modes, and collapsible sections.
- Tabbed diagram views
- Full customization of menus, toolbars, and toolboxes
- Improved window management

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Customizing Your Modeling Environment

Enterprise Glossary
In environments with a repository, administrators can deploy an enterprise glossary of terms approved for use in your environment to a special repository folder, which pushes the glossary to users to help ensure enterprise-wide consistency.
Users automatically receive updates to the glossary whenever they connect to the repository. The glossary is displayed in the Browser Glossary tab and, when enabled in a model, provides auto-completion for object names and codes, and model checks to measure and encourage glossary compliance.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > The Browser > The Glossary

Enterprise Library

In environments with a repository, administrators can deploy an enterprise library of reference models to a special repository folder, which pushes them to users to help ensure enterprise-wide consistency.

Users automatically receive updates to the library models whenever they connect to the repository. The library is displayed in a special folder in the Browser Local tab, and users can create shortcuts to and replications of these enterprise objects in their project models.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > The Browser > The Library

Role-Based Interface Customization

In environments with a repository, administrators can now use powerful profiles to customize and simplify the PowerDesigner interface for different kinds of users.

You can develop object permissions profiles to hide models, objects, and properties, or make models available in read-only form. In addition, you can develop UI and general preferences profiles to set defaults for menus, toolbars, and toolboxes, options and preferences.

These profiles are associated with users and groups in the repository and pushed to users to provide role-based customization of the PowerDesigner environment.

Documented in:
- Core Features Guide > Administering PowerDesigner > Customizing the PowerDesigner Interface

Impact Analysis Enhancements

Enhancements to impact analysis now allow you to launch an analysis from a local model and continue finding connected objects in models stored in the repository. You can also launch an analysis on any object in the repository or from the PowerDesigner Portal.

Documented in:
- Core Features Guide > Linking and Synchronizing Models > Impact and Lineage Analysis
Shortcut Improvements
External shortcuts from one model to another now display all the properties of their source object, even when its model is closed or unavailable.
Documented in:
- Core Features Guide > Linking and Synchronizing Models > Shortcuts and Replicas > Creating Shortcuts > Shortcut Properties

Customizing Property Sheets
In addition to the already rich customization available for object property sheets, you can now:
- Replace any standard property sheet tab
- Include forms within forms
- Create property sheet tabs containing sub-tabs

Extended Dependency Renaming and Enhancements
Extended dependencies are renamed as "traceability links". The new links allow you to create links between any kinds of object, to specify new types of links, and to group links by object type or by link type in the Traceability Links tab of each object property sheet.
Documented in:
- Core Features Guide > Modeling with PowerDesigner > Objects > Traceability Links

New Environments
The following new environments are supported:
- Windows 64-bit versions
- Eclipse v3.6
- Microsoft Office 2010 and Visio 2010 - import add-ins

9.2 New Symbol Features v16.0
PowerDesigner v16.0 includes new features for symbols available for all models.

Enhanced Symbol Editing
You can now edit most object properties directly from diagram symbols. You can also add, edit, and delete sub-objects, and drag and drop sub-objects from one symbol to another.

Horizontal and Vertical Symbol Layouts
New options provide greater flexibility for organizing properties on symbols, allowing multiple properties on a line and columns of properties.

![Example of properties on symbols]

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Diagrams, Matrices, and Symbols > Display Preferences

### Attribute Value Icons

You can now create sets of icons to represent extended attribute values on diagram symbols. In the following example, each entity symbol displays an icon at its top-right corner to indicate progress:

![Example of icons on symbols]

Documented in:
- Customizing and Extending PowerDesigner > Extension Files > Extended Attributes (Profile) > Specifying Icons for Attribute Values

### Automatic Link Routing and Link Bridges

Most diagrams now support a new algorithm for automatically optimizing link paths and routing them around object symbols. When link paths must cross, a bridge or “line hop” is added to clarify the flows.

![Example of automatic link routing and link bridges]

**Note**
These display preferences are enabled by default for new models, but need to be set manually for models created in previous versions of PowerDesigner.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Diagrams, Matrices, and Symbols > Symbols

## 9.3 New Data Model Features v16.0

PowerDesigner v16.0 includes new features for the Physical Data Model (PDM).  

### Sybase IQ Reference Architecture Sizing

PowerDesigner now provides a special EAM model to help you determine the architecture required to deploy a Sybase® IQ data warehouse solution to meet your anticipated workload. An advisor wizard generates architectures based on one or more hardware servers, and comparison tools help you choose the best architecture based on your requirements for cost and speed.
Customizable Data Type Mapping
When changing DBMS or generating one PDM from another, you can now specify mappings of data types down to the individual column level.

New or Enhanced DBMS Support
The following DBMS versions are added or enhanced:
- DB2 UDB v9.7 for Common Server
- DB2 v10.x for z/OS
- Netezza v5.0
- MS Access 2007 and 2010
- MS SQL Server 2008 R2 (supported via the MS SQL Server 2008 DBMS definition file)
- Sybase Adaptive Server Enterprise v15.7

New PowerDesigner Portal Features v16.0
PowerDesigner v16.0 includes new features for the PowerDesigner Portal.

Quick Search
A new Quick Search bar is available at the top of the Search page, which allows you to search directly on names, codes, and other fields of type string or text without the complexity of setting up a query.
EDITING COMMENTS, DESCRIPTIONS, AND ANNOTATIONS

Users with the new PowerDesigner Portal Composer license can now edit the comments, descriptions, and annotations of objects directly in the PowerDesigner Portal.

IMPACT ANALYSIS

Impact and lineage analysis is now available on the Analysis tab of the property sheet of all objects in the PowerDesigner Portal.

10 NEW FEATURES V15.3

The following sections describe the new features available in PowerDesigner v15.3.

Note

The Information Liquidity Model (ILM) was renamed to Data Movement Model (DMM) in this version.

In this section:

New Core Features v15.3
PowerDesigner v15.3 includes new core features available for all models.
New Business Process Model Features v15.3
PowerDesigner v15.3 includes new features for the Business Process Model (BPM).
New Data Model Features v15.3
PowerDesigner v15.3 includes new features for the Physical Data Model (PDM).
New Repository Features v15.3
PowerDesigner v15.3 includes new features for the Repository.

10.1 NEW CORE FEATURES V15.3

PowerDesigner v15.3 includes new core features available for all models.
The following enhancements are available in object lists:
- Export list to Excel
- Print list with WYSIWYG preview
- Rapid in-column filtering
- Customize columns in lists containing multiple types of objects

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Objects > Object Lists

Create Diagram from Selection
You can now create a new diagram from a selection of symbols using the new Create Diagram from Selection command.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Diagrams, Matrices, and Symbols > Diagrams > Creating a Diagram

Create Related Diagrams
You can now create a new related diagram for an object directly from the Related Diagram tab or using the new Related Diagram submenu.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Diagrams, Matrices, and Symbols > Diagrams > Specifying Diagrams as Related Diagrams

Multi-Selection in Matrices
You can now select and modify multiple cells in matrices.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Diagrams, Matrices, and Symbols > Dependency Matrices

Display Preferences
All PowerDesigner diagrams now have completely customizable display preferences, which allow you to display any of their attributes and collections in any order that you want on their diagram symbols.
In addition, the interface has been simplified to make access to format and content preferences available on tabs in a single dialog.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Diagrams, Matrices, and Symbols > Display Preferences

UI Simplifications
The PowerDesigner user interface has been simplified in the following areas:
- The Share and Copy radio buttons on the New Model dialog and in other parts of the interface are replaced by a single Embed Resource in Model tool.
- The Merge Models now displays a single tree view showing the anticipated result of the merge. You can revert to the former double-tree view format by clicking the Show Source Model button at the top left of the pane.

Plugin Support

10.2 New Business Process Model Features v15.3
PowerDesigner v15.3 includes new features for the Business Process Model (BPM).

BPMN 2.0
PowerDesigner now provides support for modeling business processes in BPMN 2.0 conversation diagrams, choreography diagrams, collaboration diagrams, and process diagrams.

Documented in:
- Business Process Modeling > BPMN 2.0 Executable

Message Format Linked to XSM
You can now use an XML model (XSM) to model the definition of a message format

Documented in:
- Business Process Modeling > Analysis BPM > Message Formats (BPM)

10.3 New Data Model Features v15.3
PowerDesigner v15.3 includes new features for the Physical Data Model (PDM).
Support for information lifecycle management is extended to handle the movement of indexes associated with the tables managed by the lifecycle. In addition, an improved lifecycle property sheet now displays all the elements required to define a lifecycle on a single tab.

Documented in:
- Data Modeling > Building Data Models > Physical Implementation > Lifecycles (PDM)

Estimate Database Size Enhancements
The Estimate Database Size mechanism now includes support for the growth in size of a database over a period of years, and the estimation algorithms can be customized through scripts in the DBMS definition file.

Documented in:
- Data Modeling > Building Data Models > Generating and Reverse-Engineering Databases > Generating a Database from a PDM > Estimating Database Size

Data Profiling Enhancements
Data profiling constraints have been enhanced to provide better case support and reuse of test data profiles, and data formats can now be reused between multiple objects.

Documented in:
- Data Modeling > Building Data Models > Physical Diagrams > Columns (PDM) > Setting Data Profiling Constraints

Oracle Database Package Templates
Database packages can now be defined through a template, so that PowerDesigner will generate packages specific to each table and update them automatically when you make changes to the table definition.

Documented in:
- Data Modeling > DBMS Definition Reference > Oracle > Database Packages (Oracle) > Database Package Templates

Metamodel Enhancements
The PDM metamodel has been simplified to provide better support for schemas, materialized views, join indexes, and inner joins.

New or Enhanced DBMS Support
The following DBMS versions are added or enhanced:
- Teradata v13
- HP Neoview
- Sybase SQL Anywhere v12

Documented in:
- Data Modeling > DBMS Definition Reference

10.4 New Repository Features v15.3
PowerDesigner v15.3 includes new features for the Repository.

Simplified Check In
A new simplified check in dialog is available, which hides less frequently used check in options behind an Advanced button.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > The Repository > Checking Documents into the Repository

PowerDesigner Portal Enhancements
The following enhancements are available in the PowerDesigner Portal:
- Customizable result columns on Search page
- Navigation through shortcuts to the target object
- Support for downloading external documents (Word etc)
- Customizable custom color themes and logos on the PowerDesigner Portal website
- Lists of sub-objects are now displayed as tabs on the parent object property sheet
- Clicking on a diagram in the Explorer displays the diagram
- Sortable columns can be sorted by clicking on the column header

Documented in:

11 New Features v15.2
The following sections describe the new features available in PowerDesigner v15.2.

In this section:
New Core Features v15.2
PowerDesigner v15.2 includes new core features available for all models.

New Enterprise Architecture Model Features v15.2
PowerDesigner v15.2 includes new features for the Enterprise Architecture Model (EAM).

New Data Model Features v15.2
PowerDesigner v15.2 includes new features for the Conceptual, Logical, and Physical Data Models (CDM, LDM, and PDM).

New Data Movement Model Features v15.2
PowerDesigner v15.2 includes new features for the Data Movement Model (DMM).

New Repository Features v15.2
PowerDesigner v15.2 includes new features for the Repository.

11.1 New Core Features v15.2
PowerDesigner v15.2 includes new core features available for all models.

Generating Objects to Other Models
You can now define your own generations of any modeling object to any other modeling object. These new object generations work in the same way as the standard PowerDesigner model generations but are completely configurable and allow you to generate only the objects you need to any kind of model.

Generation links between the source and target (generated) objects mean that you can keep the linked models synchronized.

Documented in:
- Core Features Guide > Linking and Synchronizing Models > Generating Models and Model Objects

Excel Import
There is new support for importing lists of objects and object properties from Excel spreadsheets to any model type via the File > Import menu. A simple wizard walks you through mapping your Excel lists and columns to PowerDesigner objects and properties.

Documented in:
- Core Features Guide Modeling with PowerDesigner > Objects > Importing Objects from Excel Files

Autosave
A new option instructs PowerDesigner to autosave your changes to a recovery backup file at a configurable interval to let you recover your work in the event that your modeling session exits abnormally.

Documented in:
- Core Features Guide Modeling with PowerDesigner > Customizing Your Modeling Environment > General Options

Naming Conventions
Camel case and headless camel case are now supported for code naming conventions. Changes to name to code conversion scripts can now be applied immediately to currently synchronized (or all) objects.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Objects > Naming Conventions

Dependency Matrix Enhancements
The following enhancements are available for dependency matrices:
- Export the matrix to an Excel file
- Enhanced filtering of rows and columns with persistent filtering
- Vertical column headers available
- Row heights and column widths are persisted
- Extensions now treated as standard objects
- WYSIWYG print preview and improved printing

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Diagrams, Matrices, and Symbols > Dependency Matrices

More Diagrams with Customizable Display Preferences
Extended objects, packages, and all the objects in the following kinds of diagrams now have completely customizable display preferences, which allow you to display any of their attributes and collections in any order that you want on their diagram symbols:
- Enterprise Architecture Model - All diagrams
- Business Process Model:
  - Business Process Diagram
  - Process Hierarchy Diagram
- Conceptual Data Model - All diagrams
- Logical Data Model - All diagrams
- Physical Data Model - All diagrams
- Data Movement Model:
  - Transformation Control Flow Diagram
- Object-Oriented Model - All diagrams

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Diagrams, Matrices, and Symbols > Display Preferences
RTF Formatting Preserved in HTML Reports

RTF formatting including images, tables, hyperlinks and font formatting are preserved in the generation of HTML reports.

New Object Mappings

Object mappings are now supported in both directions between the following kinds of models:

- LDM-OOM
- LDM-PDM
- LDM-CDM

Documented in:

- Core Features Guide > Linking and Synchronizing Models > Object Mappings

Improvements to Metamodel Extensions

Many improvements have been made to PowerDesigner's support for metamodel extensions (see Customizing and Extending PowerDesigner > Extension Files), including:

- Exclude standard metaclasses from the interface to simplify your working environment (see Metaclasses (Profile))
- Specify a display label and default columns when displaying a collections as a property sheet tab (see Extended Collections and Compositions (Profile))
- Specify display labels for custom forms and collections in the interface (see Extended Collections and Compositions (Profile))
- Specify a format for text extensions to obtain format-specific editors (see Extended Attributes (Profile))
- Specify a display label for, and associate contextual help with, custom forms (see Forms (Profile))
- Specify icons on tool buttons calling methods on custom forms (see Forms (Profile) > Adding Extended Attributes and Other Controls to Your Form)
- Finer-grained control over the format and content of custom symbols (see Core Features Guide > Modeling with PowerDesigner > Diagrams, Matrices, and Symbols > Symbols > Symbol Format Properties)

New Environments

The following new environments are supported:

- Windows 7
- Windows 2008 Server
- Eclipse v3.5

11.2 New Enterprise Architecture Model Features v15.2

PowerDesigner v15.2 includes new features for the Enterprise Architecture Model (EAM).

Cluster Servers and Virtual Machines

You can now model complex machine-in-machine environments using hardware and software servers and workstations.

Documented in:


11.3 New Data Model Features v15.2

PowerDesigner v15.2 includes new features for the Conceptual, Logical, and Physical Data Models (CDM, LDM, and PDM).

Sentence Generation from Relationships

English language sentences derived from the roles specified on CDM/LDM relationships between entities are now available on the relationship property sheet, and can be displayed on symbols and in reports.

Documented in:

- Data Modeling > Building Data Models > Conceptual and Logical Diagrams > Relationships (CDM/LDM) > Relationship Properties

Sybase IQ Information Lifecycle Management

Support for information lifecycle management is extended to handle access-based lifecycles and movement of pre-lifecycle data.

Documented in:

- Data Modeling > Building Data Models > Physical Implementation > Lifecycles (PDM)

Batch Import of ERwin Files

You can now import batches of ERwin files in a single operation using a new wizard.

Documented in:

- Data Modeling > Building Data Models > Migrating from ERwin to PowerDesigner

Generate PDMs from XSMs
You can now generate a PDM database structure from an XML schema.

Documented in:
- XML Modeling > Generating and Reverse Engineering XML Schemas and Other Models > Generating Other Models from an XSM

New or Enhanced DBMS Support

The following DBMS versions are added or enhanced:
- Sybase IQ v15.2
- Sybase ASE v15.5

Documented in:
- Data Modeling > DBMS Definition Reference

11.4 New Data Movement Model Features v15.2

PowerDesigner v15.2 includes new features for the Data Movement Model (DMM).

Replication Server v15.2/15.5 Enhancements

PowerDesigner provides new support for:
- Simplified connections to non-ASE replicate databases through connection profiles and connectors
- [v15.5 and higher] High Volume Adaptive Replication (HVAR)
- [v15.5 and higher] Generation of alter replication definition scripts
- Replication of SQL Statements (SQLMDL)

Documented in:
- Data Movement Modeling > Working with Replication Server

11.5 New Repository Features v15.2

PowerDesigner v15.2 includes new features for the Repository.

Extensions Visible in Repository Browser and PowerDesigner Portal

Extended objects and their properties now have the same status and visibility as standard objects in the repository Browser and PowerDesigner Portal.

Reuse Saved Searches in the PowerDesigner Portal

You can now save search queries created in the PowerDesigner Portal interface for reuse.

Documented in:

12 New Features v15.1

The following sections describe the new features available in PowerDesigner v15.1.

In this section:
- New Core Features v15.1
- PowerDesigner v15.1 includes new core features available for all models.
- New Project and Framework Features v15.1
- PowerDesigner v15.1 includes new features for projects and frameworks.
- New Enterprise Architecture Model Features v15.1
- PowerDesigner v15.1 includes new features for the Enterprise Architecture Model (EAM).
- New Business Process Model Features v15.1
- PowerDesigner v15.1 includes new features for the Business Process Model (BPM).
- New Data Model Features v15.1
- PowerDesigner v15.1 includes new features for the Physical Data Model (PDM).
- New Data Movement Model Features v15.1
- PowerDesigner v15.1 includes new features for the Data Movement Model (DMM).
- New Object-Oriented Model Features v15.1
- PowerDesigner v15.1 includes new features for the Object-Oriented Model (OOM).
- New Repository Features v15.1
- PowerDesigner v15.1 includes new features for the Repository.

12.1 New Core Features v15.1

PowerDesigner v15.1 includes new core features available for all models.

New Model Dialog

The New Model dialog has been completely redesigned to provide greater visibility to the diagrams that are available in each type of model. The new dialog is
customizable so that you can:

- Organize the choice of models however you want
- Hide certain kinds of models from certain kinds of users
- Restrict or predefine the choice of target language using a new kind of model template

Documented in:

- Core Features Guide > Modeling with PowerDesigner > Getting Started with PowerDesigner > Creating a Model
- Core Features Guide > Modeling with PowerDesigner > Getting Started with PowerDesigner > Creating a Model > Model Templates

Welcome Page

The new Welcome page gives you one-click access to all your recent projects, workspaces, and models, as well as providing a direct link to the New Model and New Project dialogs and a range of help materials.

Documented in:

- Core Features Guide > Modeling with PowerDesigner > Getting Started with PowerDesigner > Creating a Model > The Welcome Page

Metamodel Extension Wizards

You can now quickly add extensions to your PowerDesigner models with wizards available directly from object property sheets. You can specify new attributes and lists of associated objects and the changes to the underlying PowerDesigner metamodel are automatically saved in an extension file, which can be deployed to other users and edited in the Resource Editor.

Documented in:

- Core Features Guide > Modeling with PowerDesigner > Objects > Extending Objects > Adding New Properties to an Object

Dependency Matrix

Dependency matrices, which allow you to analyze the dependencies between different kinds of objects, now display the hierarchy of parent objects. You can now display dependencies between types of objects that are not directly related by constructing complex paths traversing the PowerDesigner metamodel using the new Dependency Path Definition dialog.

Documented in:

- Core Features Guide > Modeling with PowerDesigner > Diagrams, Matrices, and Symbols > Dependency Matrices

More Diagrams with Customizable Display Preferences

Extended objects, packages, and all the objects in the following kinds of diagrams now have completely customizable display preferences, which allow you to display any of their attributes and collections in any order that you want on their diagram symbols:

- Enterprise Architecture Model - All diagrams
- Business Process Model - All diagrams
- Data models:
  - Physical Data Diagram
  - Multidimensional Data Diagram
- Object-Oriented Model:
  - Use Case Diagram
  - Activity Diagram
  - Statechart Diagram
  - Interaction Overview Diagram
  - Deployment Diagram

Documented in:

- Core Features Guide > Modeling with PowerDesigner > Diagrams, Matrices, and Symbols > Display Preferences

Improved Property Filtering

The Customize Columns and Filter dialog now includes a new Operator column with a list of common operators to simplify writing filter expressions.

Documented in:

- Core Features Guide > Modeling with PowerDesigner > Objects > Object Lists > Customizing Object List Columns and Filtering Lists

Improved RTF Support

The PowerDesigner RTF editor provides improved support for tables and bulleted lists and the preservation of Word formatting. It now allows the insertion of pictures anywhere RTF input is supported.

Other New Core Features

- Metamodel Help More Accessible: You can now access the documentation of the PowerDesigner metamodel directly from an object's property sheet.
- Right-Clicking a Group of Symbols: When you select a group of symbols and right-click any of them, you can now modify all of them in any way that is appropriate.
- Plugin Support: The PowerDesigner plugin for Eclipse now supports Eclipse v3.4.

12.2 New Project and Framework Features v15.1

PowerDesigner v15.1 includes new features for projects and frameworks.
Framework Diagram

The new framework diagram provides support for modeling frameworks that are not based on a matrix format. You can create framework nodes and draw connections between them in any format required. Individual nodes can be decomposed into sub-framework diagrams. Framework diagram nodes support all the same kinds of actions as framework matrix cells.

Documented in:
- Core Features Guide > Modeling with PowerDesigner > Projects and Frameworks

Save Order Between Folders and Models

You can now reorder folders and models within a project by drag and drop.

12.3 New Enterprise Architecture Model Features v15.1

PowerDesigner v15.1 includes new features for the Enterprise Architecture Model (EAM).

New Object Properties

Many objects in the EAM have additional properties to enable you to model them more fully.

Documented in:
- Enterprise Architecture Modeling

Richer Diagrams

Hardware and software servers, network nodes, workstations, mobile devices, and networks, previously only available in technology infrastructure diagrams are now also authorized in application architecture diagrams.

In city planning diagrams, business functions can now be decomposed and display sub-functions.

Documented in:
- Enterprise Architecture Modeling

Improved Exchange of Objects with Other Models

When importing or exporting objects from or to other PowerDesigner models, sub-objects are now automatically included.

Documented in:
- Enterprise Architecture Modeling > Importing and Generating and Exporting from an EAM > Exporting and Importing Objects to and from Other Models

Improved Visio Import

You can now import custom properties defined in Visio.

Documented in:
- Enterprise Architecture Modeling > Importing and Generating and Exporting from an EAM > Importing Visio Diagrams into PowerDesigner

12.4 New Business Process Model Features v15.1

PowerDesigner v15.1 includes new features for the Business Process Model (BPM).

Multi-Pool Support in Business Process Diagrams

Business process diagrams can now contain multiple pools of swimlanes. Linking between pools is supported, and you can group swimlanes and specify custom names for these groups.

Documented in:
- Business Process Modeling > Analysis BPM > Organization Units (BPM)

Improved Visio Import

You can now import custom properties defined in Visio.

Documented in:

12.5 New Data Model Features v15.1

PowerDesigner v15.1 includes new features for the Physical Data Model (PDM).

Sybase IQ - Information Lifecycle Management

Sybase IQ 15.0 provides new data placement capabilities and supports hierarchical storage management with relocation of less critical data to cheaper
PowerDesigner provides a simple modeling structure to cost effectively manage "aging" of data inside the data center from 1st tier high performance storage for frequently accessed data through 2nd tier near-line storage for data that is infrequently accessed to 3rd tier archive storage for data that must remain available for regulatory audits.

**DBMS Triggers**

DBMS triggers are now supported for Oracle and MS SQL Server. These triggers are not associated with any table or view, and fire on modifications to the database structure itself, such as the creation or dropping of a table, or events like startup, shutdown, login etc. DBMS triggers can use trigger templates and trigger template items, just like table and view triggers.

**New or Enhanced DBMS Support**

The following DBMS versions are added or enhanced:
- Teradata v12
- IBM DB2 UDB v9.5 Common Server
- Sybase IQ v15.0 and v15.1

**12.6 New Data Movement Model Features v15.1**

PowerDesigner v15.1 includes new features for the Data Movement Model (DMM).

**Replication Server® v15.x**

PowerDesigner now supports modeling for Replication Server® v15.x, and new usability enhancements make it easier to select maintenance users from attached PDMs. Data mapping for heterogeneous replication environments is now supported to allow the transparent remapping of datatypes for Oracle and other non-Sybase primary databases.

**12.7 New Object-Oriented Model Features v15.1**

PowerDesigner v15.1 includes new features for the Object-Oriented Model (OOM).

**XMI - Improved Support**

PowerDesigner now supports the import and export of UML models in the format XMI v2.1.

**Improvements to Activity Diagram**

Activity diagrams now support the creation of multiple starts and multiple pools of swimlanes. Linking between pools is supported, and you can group swimlanes and specify custom names for these groups. In addition you can now decompose activities directly in the parent diagram using the editable composite view mode.

**Improvements to Statechart Diagram**

The Statechart diagram now supports forks and joins, and states can be decomposed directly in the parent diagram using the editable composite view mode.

**12.8 New Repository Features v15.1**

PowerDesigner v15.1 includes new features for the Repository.

**LDAP**

You can now configure repository access to be controlled by an LDAP server, so that it is no longer necessary to create separate repository accounts.
Resource Sharing

You can now store and deploy PowerDesigner resource files (target DBMSs, OO languages, etc) via the repository. A new auto-update option means that your team will always have the latest version of your modeling target with all your extensions. You can combine your shared resource files with the new Model Category Sets to enforce their use for model creation.

Documented in:

Hyperlinks in Stored Diagrams in PowerDesigner Portal

Now you can click on any object symbol in a diagram viewed in the PowerDesigner Portal, and go directly to the object's property sheet.